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A User Manual 

A.1 Meteo Plus operation via screenshots 
 
The philosophy and usage of Meteo Plus are being presented via some screenshots. 
 
A.1.1 Main View 
 
This is the main screen of Meteo Plus. One can see three active monitors: The Aegaeo monitor in 
the up left corner (see section 1.7), the Log (Logging) monitor bellow it (see section 1.6) and the 
Ship (True wind) monitor on the right (see section 1.8). The splash screen appears on start-up. 
These monitors and more that are not active at given setup can be used to present information from 
several data sources. 
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A.1.2 Setup screen 
 
By pressing Edit > Settings in the main menu, the Setup settings dialog appears. You can see 
current setup including three monitors that we described before (on the bottom) and five data 
sources (instruments): GPS, Compass, Weather station, True wind speed calculator and True wind 
gust calculator. While the three first instruments represent true data sources, from external world, 
the last two are virtual data sources which just process data provided by the first three. 
 

 
 
A.1.3 Add new instrument 
 
By pressing the add button bellow the instrument list, new instruments can be added via the dialog 
bellow. Unlimited number of instruments of the same type can be added as long as they don’t lock 
the same resources (e.g. don’t use the same serial port). 
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The list contains some default instruments, released with Meteo Plus. These are: 
 
Instrument Description 
Aanderaa weather 
station interface 

Aanderaa weather station interface retrieves data from Aanderaa's weather 
station via serial port 

General NMEA 
instrument 

NMEA instrument retrieves data from instruments supporting NMEA 
protocol via serial port 

True wind calculator True wind instrument calculates the made-good value of wind's gust from 
the apparent wind measured on board and ship's speed - heading 

Unit converter This is a generic multi-variable mathematic expression calculator that can 
be used for unit conversion and computation of complex expressions of 
measured quantities 

 
Additional custom instruments that cover any need can be added easily by adding small .jar files in 
the classpath. 
 
A.1.4 Add new monitor 
 
By pressing the add button bellow the monitor list, new monitors can be added via the dialog 
bellow. Unlimited number of monitor of the same type can be added. 
 

 
 
The list contains some default monitors, released with Meteo Plus. These are: 
 
Monitor Description 
Aegaeo monitor This is a custom monitor for Aegaeo ship. 
Graph monitor This is a graph monitor. It shows a chart of the selected channel 
Logging monitor This is a logging monitor with database connectivity 
Panel This is a panel that can show up to three channels, formatted with text 
Ship monitor This is a monitor that shows ship's speed and wind's direction 
 
Additional custom monitors that cover any need can be added easily by adding small .jar files in the 
classpath.  
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A.1.5 NMEA instrument settings 
 
By double clicking an NMEA instrument in the instruments list, the NMEA Instrument Settings 
dialog appears. Via this dialog one can select the COM port that the instrument is connected, the 
Baud rate and other communication options. One can see the “Outputs” list bellow the Serial port 
settings. This is empty for a newly created NMEA instrument. By pressing add new output channels 
are being added. By the Output properties on the right, output channels can be customized: 
 
1. General: Name and descriptions 
2. NMEA: The parameter should the output channel listen to 
 
For example, a common NMEA string is the following: 
 
$GPRMC,085342,A,3757.570,N,02336.094,E,00.1,158,0605105,4,E*7D 
 
The third parameter (3757.570) is the Latitude and the fifth (02336.094) is the Longitude. In order 
to make channels that watch these parameters, one should select as Sentence Id: $GPRMC and set 
parameter number to 3 and 5 respectively. As one can see this instrument provides a lot  

 

 
 
3. Type and transforms: Details about the output of a channel. Via these options, one can declare if 
the channel is expected to provide Textual or Numerical data. Unit explicitly declares the unit of the 
measured quantity. It’s recommended to add units when available for the sake of clarity. The 
“Transform” field provides the ability to add custom formulas to transform numerical values. This 
can be useful for example if you want to have a channel for speed in miles/hour and another channel 
for the same speed in km/h. You add two channels that differ only in the formula field. If the 
formula contains an error, it’s presented in the Messages box bellow. For more information about 
the mathematical expression builder, see in the section bellow. 
 
A.1.6 The mathematical expression builder 
 
The mathematical parser is used to perform arithmetic operations in variable values (usually X but 
in many cases can be more than one). Formulas may contain variable names, numbers, all basic 
operations (+ - * /), some more: COS, SIN, TAN, EXP, SQRT, ABS, ACOS, ASIN, ATAN, LOG, 
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TODEGREES, TORADIANS, POWER, MAX, MIN and some constants: E(), PI() and 
RANDOM() (creates random numbers between 0 and 1 using JAVA’s Math.random()). ACOS, 
ASIN, ATAN and LOG should be handled with care because of their “dangerous” mathematical 
properties. The decimal separator is be the dot (‘.’), engineering number format (e.g. 4.32e-15) is 
supported, parenthesis can be used and formulas are case insensitive.  
 
A.1.7 Aanderaa instrument settings 
 
The Aanderaa instrument looks pretty much like the NMEA instrument. The only difference is the 
major simplification on the “Aanderaa parameter” section on the right. Aanderaa’s “Sensor 
Scanning Unit 3010” sends a string of twelve integer numbers from 0 to 1023 (10bit ADC) via the 
serial port (1200baud).  
 

 
 
The first number is a reference voltage as measured by the ADC and should be 0262. Subsequent 
numbers correspond to the analogue voltages measured by the instrument. An example of a 
sequence is this one: 0262  0013  0020  0425  0874  1023  0523  0716  0585  0574  0586  0558  
One can add output channels in the same way as the GPS instrument (press the Add button). Then 
the parameter number has to be defined. For example the parameter number for the reference 
voltage is 1. In most of cases, the number that is being received doesn’t correspond directly to any 
physical quantity. It’s therefore expected that complex transforms (formulas) are going to be used in 
order to evaluate physical quantities. This can be done with the mathematical expression parser (see 
section A.1.6). 
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A.1.8 True wind instrument settings 
 
The true wind instrument calculates true wind’s speed and direction given the apparent wind’s 
speed (and direction), ship’s speed (and direction) and ship’s heading. This is a virtual instrument as 
it doesn’t create data on its own rather than processes data from other source instruments. Units of 
quantities involved with true wind instrument should be compatible in order to obtain a meaningful 
result. This instrument is useful for the calculation of both wind’s speed and wind’s gust. 
 

 
 
One can change the source of an input value by pressing the edit button. This way the channel select 
dialog will appear (see section A.1.8 bellow) and let him select the source channel for the given 
input. 

A.1.9 The channel select dialog 
 
By using the channel select dialog, one can select sources for inputs of a module (instrument or 
monitor). As one can see, it provides useful information about instruments and their channels that 
are available. It should be noted that if a module has an input that expects numeric values, outputs 
that provide textual data will not be presented in the list. Additionally if an instrument invokes this 
dialog, its outputs are not presented in the list in order to prevent loop-connections that would stall 
the system. Unfortunately such loop-connections can be performed by cross connecting two 
instruments so SPECIAL ATTENTION should be paid. One can also see a “Clear” option on the 
bottom of the tree. This disconnects completely the given input. 
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A.1.10 Log and database monitor settings 
 
By double clicking the Logging monitor in the Setup Setting dialog, the Log monitor settings dialog 
appears. By using this monitor, data from various instrument can be presented in a table and be 
stored in an ODBC database using a predefined schema. Via these settings, the database ODBC 
service name is being stated and optional Username and Passwords. Unlimited number of inputs 
can be selected for viewing and logging by simply pressing the add button. Then the channel select 
dialog (see section A.1.8) appears and prompts the users to select desired input. If the “Log to 
database” check box on the right is unchecked for a channel, it only appears in the table but it 
doesn’t get logged to the database. Move Up and Move Down let the user order conveniently the 
channels in the table view. 
 

 
 
A.1.11 Aegaeo monitor settings 
 
The Aegaeo monitor is a monitor that shows some predefined quantities that are useful for an 
Oceanographic ship like Hellenic Centre for Marine Research’s Aegeao ship. It also graphs out the 
atmospheric pressure change on the last one to twelve hours in order to ease the weather reports. 
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A.1.12 Ship monitor settings 
 
The ship monitor is presenting on a graph the ship and arrows showing the direction and magnitude 
of the ship’s speed and wind’s speed. The sources for various inputs can be selected by pressing the 
Edtit button and a max value must be defined for each input in order to present correct (normalized) 
arrows. This monitor is being expected to be used in conjunction with the True wind instrument. 
 

 
 
A.1.13 About dialog 
 
About dialog (Help > About) presents a quick description of the Meteo Plus software, copyright 
information and contact information of the author. 
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A.1.14 Actual screen view 
 
When application loads or setting dialog closes operation of Meteo Plus begins. You may have to 
wait several seconds till data from slower sources (like Aanderaa instrument) get received and 
present. Information from faster sources like GPSs will be presented immediately. 
 

 
 
 
A.1.15 Save setup 
 
Correctly configuring the Meteo Plus requires some level of experience. In order to allow 
experimenting with different setups, the settings don’t get saved until the Save setup (File > Save 
Setup) menu option gets pressed. 
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A.2 Application loading 
 
One has just to run the meteoplus.bat file. Under linux, an equivalent shell script should be made. 
 
@"C:\Program Files\Java\j2re1.4.2_01\bin\java" -classpath "app.jar;comm.jar;jfreechart-
0.9.11.jar;jcommon-0.8.6.jar" gr.doit4me.meteoplus.MeteoPlus 
 

A.3 Setup Configuration for Aegaeo Ship 
 
 
 
 
 
 

GPS 

Compass 

Weather station 

True Wind 
Calculator

True Gust 
calculator

Logging Monitor 

Aegaeo Monitor 

True Wind Monitor 

Physical Instruments Virtual Instruments Monitors 

Database 
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B Developer’s Documentation 
 
UML diagrams that may help a developer follow. 

B.1 Core classes: gr.doit4me.meteoplus.core 
 

0..*

provides

0..*

notifies

0..*has

0..*
holds

0..*

holds

notifies

InputSocket

+connectToOutputSocke
+registerSocketListener:

 type:int
 instrumentName:String
 outputSocketName:Strin
 numericalValue:double
 textValue:String
 userString:String

Setup

+start:void
+stop:void
+getSocketWithName:O
+changeObjectName:bo
+addObject:String
+removeObject:String
+canRemoveChannel:bo
+changeChannelName:v

 instruments:Instrument[
 monitors:Monitor[]

interface
SocketListener

+valueChanged:void
+valueChanged:void

interface
Instrument

outputSockets:OutputS
defaultChannelName:

DefaultModule

interface
Monitor

 panel:JPanel
 bounds:Rectangle
 resizable:boolean
 icon:boolean

OutputSocket

+TYPE_TEXT:int
+TYPE_NUMBER:int

+connectInputSocket:vo
+disconnectAll:void

 unit:String
 name:String
 type:int
 description:String
 numericalValue:double
 textValue:String
 userString:String

DefaultInstrumen

interface
Module

+showAbout:void
+showSettings:void
+start:void
+stop:void

 type:String
 name:String
 description:String
 setup:Setup
 inputSockets:InputSocket[]

DefaultMonito

ModuleBrowse

+scan:Module[]

Has static
method that
allows
browsing of
available
Modules

Implementations
can be found in
gr.doit4me.meteo
plus.monitors

Implementations
can be found in
gr.doit4me.meteo
plus.instruments
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B.5 Propagating messages example: 
TrueWindInstrument.calculateValues() 
 

 




